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Oracle Copyright

Copyright © 1995, 2009, Oracle and/or its affiliates. All rights reserved.

This software and related documentation are provided under a license agreement containing
restrictions on use and disclosure and are protected by intellectual property laws. Except as
expressly permitted in your license agreement or allowed by law, you may not use, copy,

reproduce, translate, broadcast, modify, license, transmit, distribute, exhibit, perform, publish or
display any part, in any form, or by any means. Reverse engineering, disassembly, or decompilation
of this software, unless required by law for interoperability, is prohibited.

The information contained herein is subject to change without notice and is not warranted to be
error-free. If you find any errors, please report them to us in writing.

If this software or related documentation is delivered to the U.S. Government or anyone licensing it
on behalf of the U.S. Government, the following notice is applicable:

U.S. GOVERNMENT RIGHTS

Programs, software, databases, and related documentation and technical data delivered to U.S.
Government customers are "commercial computer software" or "commercial technical data"
pursuant to the applicable Federal Acquisition Regulation and agency-specific supplemental
regulations. As such, the use, duplication, disclosure, modification, and adaptation shall be subject
to the restrictions and license terms set forth in the applicable Government contract, and, to the
extent applicable by the terms of the Government contract, the additional rights set forth in FAR
52.227-19, Commercial Computer Software License (December 2007). Oracle USA, Inc., 500
Oracle Parkway, Redwood City, CA 94065.

This software is developed for general use in a variety of information management applications. It is
not developed or intended for use in any inherently dangerous applications, including applications
which may create a risk of personal injury. If you use this software in dangerous applications, then
you shall be responsible to take all appropriate fail-safe, backup, redundancy and other measures
to ensure the safe use of this software. Oracle Corporation and its affiliates disclaim any liability for
any damages caused by use of this software in dangerous applications.

Oracle is a registered trademark of Oracle Corporation and/or its affiliates. Other names may be
trademarks of their respective owners.

This software and documentation may provide access to or information on content, products and
services from third parties. Oracle Corporation and its affiliates are not responsible for and
expressly disclaim all warranties of any kind with respect to third party content, products and
services. Oracle Corporation and its affiliates will not be responsible for any loss, costs, or damages
incurred due to your access to or use of third party content, products or services.
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Preface

The Agile PLM documentation set includes Adobe® Acrobat PDF files. The Oracle Technology
Network (OTN) Web site http://www.oracle.com/technology/documentation/agile.html contains the
latest versions of the Agile PLM PDF files. You can view or download these manuals from the Web
site, or you can ask your Agile administrator if there is an Agile PLM Documentation folder available
on your network from which you can access the Agile PLM documentation (PDF) files.

Note  To read the PDF files, you must use the free Adobe Acrobat Reader version 7.0 or later.
This program can be downloaded from the Adobe Web site http://www.adobe.com.

The Oracle Technology Network (OTN) Web site
http://www.oracle.com/technology/documentation/agile.html can be accessed through Help >
Manuals in both Agile Web Client and Agile Java Client. If you need additional assistance or
information, please contact support http://www.oracle.com/agile/support.html
(http://www.oracle.com/agile/support.html) for assistance.

Note  Before calling Oracle Support about a problem with an Agile PLM manual, please have
the full part number, which is located on the title page.

TTY Access to Oracle Support Services

Oracle provides dedicated Text Telephone (TTY) access to Oracle Support Services within the
United States of America 24 hours a day, 7 days a week. For TTY support, call 800.446.2398.
Outside the United States, call +1.407.458.2479.

Readme

Any last-minute information about Agile PLM can be found in the Readme file on the Oracle
Technology Network (OTN) Web site http://www.oracle.com/technology/documentation/agile.html

Agile Training Aids

Go to the Oracle University Web page
http://www.oracle.com/education/chooser/selectcountry_new.html for more information on Agile
Training offerings.

Accessibility of Code Examples in Documentation

Screen readers may not always correctly read the code examples in this document. The
conventions for writing code require that closing braces should appear on an otherwise empty line;
however, some screen readers may not always read a line of text that consists solely of a bracket or
brace.

Accessibility of Links to External Web Sites in Documentation

This documentation may contain links to Web sites of other companies or organizations that Oracle
does not own or control. Oracle neither evaluates nor makes any representations regarding the
accessibility of these Web sites.
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Chapter 1
Agile Help Menu Integration — Step by Step

Downloading UPK Content

1. To download Agile PLM UPK content from Oracle E-Delivery go to
http://edelivery.oracle.com
2. Select User Productivity Kit and Tutor as the Product Pack and Microsoft

Windows (32-bit) as the Platform. Click Go.
Media Pack Search

@ Instructions
Frequently Asked Questions

1. Review the License List to determine which Product Pack or o What is a Media Pack?

Packs you need to download. s How do I find the Media
2. Select the Product Pack and Platform and click "Go". Pack that I need?
3. If there is only one result, you will see the download page. » How do I get my license

If there are multiple results, select one and click "Continue". code?

& More...
Select a Product F'acklUser Productivity Kit and Tutor j 0]

Platform | Microsoft Windows (32-bit) =]

B

Results
L Release _
Select | Description - Part Number | Updated # Parts [ Size
i Oracle E-Business Suite Release 12.1 - 12.1.0.0.0 B55406-02 AUG-05-2009 12/
User Productivity Kit Content Media Pack 1.6G
[ Oracle E-Business Suite - User 12.0.0.0.0 B37243-05 APR-05-2009 30/
Productivity Kit Release 12 Media Pack 5.8G
& Oracle Tutor 12 Media Pack for 12.0.0.0.0 B37323-01 APR-08-2008 if
Microsoft Windows 88M
¢ | Oracle Aqile Release 8.3 User 9.3.0.0.0 B55248-01 JUN-17-2009 6/
Productivity Kit Content Media Pack for
: = 1.4G
Microsoft Windows
e 1D Edwards World A9.2 User 9.2.0.0.0 B55780-01 AUG-05-2009 16/
Productivity Kit Content Media Pack 9.3G

3. Select Oracle Agile Release 9.3 User Productivity Kit Content Media Pack for

Microsoft Windows and click Continue.
4. Click the download button for the content you intend to use.
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Part Size
Select Name Number (Bytes)
Download ;)r;cle Agile User Productivity Kit for Agile Product Collaboration V16842-01 283M
Download | Oracle Agile User Productivity Kit for Agile Product Cost V16843-01 231M
Management 9.3
Download | Oracle Agil.e User Productivity Kit for Agile Product Governance V16844-01 14aM
and Compliance 9.3
Download | Oracle Agile User Productivity Kit for Agile Product Quality V16845-01 212M
Management 9.3
Download Qracle Agile User Productivity Kit Fundamentals for Product V16846-01 215M
Lifecycle Management 9.3
Download | Oracle Agile User Productivity Kit for Agile Product Portfolio V16847-01 206M
Management 9.3
Total: 6

5. Unzip the downloaded file and review the directory structure:
[ P

[)35.%
3 Publish

r.;j Feadme. tat
EELIF'K Content Getting Started Guide. pdf |

Importing UPK Content for Customization

1. Users who intend to customize the UPK content or combine multiple modules to
host on the same web server must import the .odarc file from the 3.5.x folder
into UPK Developer 3.5.x.

2. Once imported into UPK Developer, edit the content as desired, and publish the
revised content by selecting File > Publish and following the wizard steps.

3. Consult the UPK Content Development guide for details about importing,
editing, and publishing UPK content.

Hosting UPK Content

1. To host UPK content, move the PlayerPackage directory to a directory
accessible by your Web server.

a. If using “as is” content, open the Publish directory and move the
PlayerPackage 3.5 directory.

b. If using customized content, move the PlayerPackage directory that
resulted from publishing the content in your UPK Developer.

2. Create a site instance on your Web server that points to the PlayerPackage
directory you just moved to the accessible directory. The next steps illustrate
setting up a Web site instance within Internet Information Services (IIS) (Note:
you may use any Web server).
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a.

File Edit Wiew Favorites Tools  Help

Note the location of the PlayerPackage directory.

oy ]

| 4

Agdr&lﬂ (C:\Publishing Content\PlaverPackage

jGo

Qb T 1. sw
X

IC5) Publishing Data

|

v
| |

Folders Marme  ~ Size | Type | Date Modified
com :| ) agile File Folder 6{26/2009 1:25 PM
4830424cBe0cd0bad [ audio File Folder 6{26/2009 1:05 PM
del ) certificate File Folder 6f26/2009 1:05 PM
) Documents and Settings I hess File Folder 6f26/2009 1:05 PM
2 files Ihhelp File Folder 626/2009 1:25 FM
& heapdurp Ihimg File Folder 6/26/2009 1:05 FM
3 tnetpub Chis File Falder 6/26/2009 1:05 PM
[hpreferences File Folder 6fz26/2009 1:05 PM
I=hquerydb File Folder &f26/2009 1:04 PM
|5 skdhemni File Falder 6f26/2009 1:25 PM
[)template File Folder 6f26/2009 1:01 PM
[htoc File: Folder 6{26/2009 1:05 PM
[tpc File: Folder 6{26/2009 1:03 PM
ﬁjdefault.htm SKB HTML Document 6{26/2009 1:25 PM
) audio &] dhtml_kp. html 7KB HTML Document &/26/2009 1:05 PM
£ certificats firefnx.cmd 1 KB windows Command ... 6/26[2009 1:05 PM
3 css ﬁjindex.htm\ SKE HTML Document 6f26/2009 1:05 PM
3 help @kp.html 235 KB  HTML Document 6/26/2009 1:25 PM
3 mg A = kpxml F63KE =ML Document 626/2009 1:25 FM
s notsupp.html 1 KB HTML Document 6fz26/2009 1:05 PM
3 preferences outline.]s 1 KB JScript Scripk File 6fz6/2009 1:01 M
3 querydb play.exe 260 KB Application &f26/2009 1:05 PM
2 rales . xml 1 KB ¥ML Document 6f26/2009 1:04 PM
@jtoc.htm\ 7KE HTML Document 6f26/2009 1:05 PM
topicmap.]s 60KE  IScript Script File 6f26/2009 1:25 PM
2 warsion,xml 1 KB  ¥ML Document 6f26/2009 1:25 PM

| Bl

¥9 Fle Action View iindow Help
e | B@mEFHNB[R[(2]r 50

?g Inkernet Information Services
=- w0 PERFTEST (local computer)
| Application Pools

Al Tasks

Web Site {From fileh. ..

Wiew
TMew \Window Frarm Here

Refresh
Export List,..

Properties

Help

Within IIS, create a new Web Site (right-click on Web Sites) that will

serve the Agile UPK content.
tInternet Information Services (I1S) Manager
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c. Open the properties for the new Web Site (right-click).

V9 Fle  Action VYiew Window

[ Internet Information Services (IIS) Manager

Help

e | AE XEFRBE 22 =

?.5 Internet Information Services
- -_‘!9 PERFTEST (local computer)
__J Application Pools
[-_J Web Sites
___J wWeh Service Extensions

[Descripkion

8 Default 'web Site

Explore
Open
Permissians
Erowse

Stark
Stop
Pause

e
Al Tasks

Mew Window From Here

Delete
Rename
Refresh

d. On the Web Site tab, set a TCP port that will not conflict with other

applications.

AgileUPK Properties EH
Directory Security | HTTP Headers | Custom Errors | ASP.MET |
Web Site | Performance I ISAPI Filkers I Harne Directory I Docurments

r—web site identification

Descripkion:
IP address: I(AII Uniassigned) j Advanced. .. |
TCP port: 00 S5L pork:

[~ Connections

¥ Enable HTTF Keep-Alives

Conneckion timeaout: I 120 seconds

—I¥ Enable logging

Active log Farmat:

|W3C Extended Log File Format

j Properties. .. |

o1

Cancel Appl

Help
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3.

e. On the Home Directory tab, point the Local path to the PlayerPackage

f.
In Agile Java Client, add the following link as the Online Help Manuals URL
(Host refers to your Web Server referenced in the prior step):

http://<Host>:<port>/agile/hemi/agile_gateway.html

directory.
AgileUPK Properties FE
Directary Security | HTTP Headers | Cuskam Errors | ASP.MET

Web Site: | Perfarmance | ISAPI Filters Horne: Direckory Dacuments

/rThe content For this resource should come From:

& i directory located on this computer:

£~ A share lacated on another computer
A redirection ko a URL

Local path: I C:hPublishing Conkent\PlayerPackage Browse. ..
| Scripk source access v Log wisits
v Read [¥ Index this resource

M trite

[ Directary browsing

i

Application settings

Application nanme: I Default Application Remove |
Starting poink: <AgileUPk =

Configuration... |
Execute permissions: INone j
Application poal: IDeFauItnppF‘ool j Unload |

QK I Cancel | Apply | Help |

Ensure that the new Web Site is started.
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Example: http://Perftest:800/agile/hemi/agile_gateway.html

< Agile Product Lifecycle Management (PLM) 9 [=] B3
File Edit “iew Tools Settings ‘Window Help

- e Dq‘w ) ‘lﬁ.ll ;l'ﬁ!-lQuickSearch e Q‘v3| Sy El‘ﬂ
J'. Locations

Search | Analytics and Reports  Admin I : % Locations

n %| S H S | 2" gl TAFGatcn| File Manager | History

Seltings
[#-{5f] Data Settings Application Server URL |BIueOneUPK

] {s7] Workflow Settings
[#]-{] User Settings
[#]-{¢] System Settings
EI@ Server Settings

Web Server URL Inttp:,l',l'BIueOneUPK.qa.agilesoft.com:???B,I'Agile,l'F‘LMServlet

DB Server Hostname |DSCD.|'-\.0.DG.agile.agilesoft.com

Locations
- Bl LB Server Usernarne |b|ueoneu|:uk a3

Marne |58rver Location
B! Preferences

E W=TiEsas Java Client URL I:,l',l'BIueOneUPK.qa.agilesoft.com:???S,I'Javaclient,l'start.jsp

; % Task Monitar
(Al Task Configuration rline Help Manuals URL Ihttp:,I',I'Perftest:SDD,I'agiIe,l'hemi,l'agile_gateway.html
[#-{5#] Examples

| |Agile, Adrmin33 (admin33) |ormi:,l',l'BIueOneUPK.qa.agilesoft.com,l'.ﬂgile |9.3 (Build 44) |
4. Test the UPK Player by selecting the Help option under the Help menu button in
Agile Web Client.
ORACLE

¥ | L searche
b (4 com Keyboard Controle

» b Gt Quick Tours
» [ comporerrmmenms———

Maintaining a UPK and Documentation Link

1. If you want the option of selecting a standard documentation link or the UPK
link when selecting Help, create a custom URL file by copying the
odcontenturl.js file located in the \PlayerPackage\agile\hemi directory and
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renaming the new file as odcustomurl.js.

% C: Publishing Content'PlayerPackage’ agile’,hemi

File Edit Yiew Favworites Tools  Help

QBack ~ 3 - ¥ | - search | [ Folders | (-

Address |75 C:\Publishing Content|PlayerPackageagileihemi
Folders » | _Mame =
= I5) Publishing Content N agile_gatewa;.r.html
=l I PlayerPackage 'j':'tt'-'rl's
pEdodcustonnur. js

= 25 agile =
3 hemi Ddrbhcustumsetup.js
& audio stdhemiscripts.js
3 certificate || stdie-config.xml
i] 55

1= help
In the odcustomurl.js file remove the comment marks (//) and add definitions

for the following parameters:
Gkod.Variables.OD APPLICATIONHELP URL =

"http://www.oracle.com/technology/documentation/agile.html";
Gkod.Variables.OD SHOWHELPTEXT = “Documentation”;

When users select Help in Agile PLM they will now be directed to the following screen

first:

Oracle User
Productivity Kit

UPK

Documentation
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